
"dumb virtue" on-line documentation (copyright Kevin Eric Saunders 1985) 

Command index:  Select command name with mouse and use Find (Command-/) to find entries. 

>Anchor >Blank >Cancel >Copy >CR >Cut >Delete >Delete >Down >dv >desk
>Edit >Find >Get >Find >Free >Input >Left >Literal >Option >Output
>Page >Paste >Print >Prompt >Record >Reformat >Reset >New >Right >Save
>Scroll >Select >Select all >Sentence >Set >Tag >Terminal >UNIX
>UpFront >Up >Word wrap >Wrap >Yank 
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1:  Introduction 

About this text:  all bracketed text [ ... ] refers to features of the program not yet 
implemented; the word WARNING is used to highlight dangerous operations throughout this 
document; and the "selection point" for text is referred to as the "cursor" throughout 
this document. 

1.1:  Description 

"dumb virtue" is a program for the Macintosh providing multi-window text-editing and 
single-window terminal emulation. It supports the association of terminal input and 
output with different windows, and the editing of local text window contents using both 
the standard Macintosh mouse-driven commands and a complement of cursor motion commands.  
Plain ASCII file uploading can be performed with hosts using timed line sends or xon/off 
flow control. 

The program provides a window which executes a subset of the commands in the ANSI X3.64 



(DEC VT100-like) terminal protocol so that large files on a remote host can be quickly 
and conveniently edited.  This emulator can use any font (including variable width fonts) 
in any existing size, and runs at over 800 cps.  [A window which can be used to draw 
graphics commands intended for the Tektronix 4010 is also provided.] 

1.2:  The keyboard 

The command (clover symbol) key is used to select menu items from the menus.  To execute 
a menu command from the keyboard rather than with the mouse, simply press the command key 
with your thumb and press the other character listed in the menu at the same time. 

When you are communicating with another computer and need to send control signals (e.g., 
Control-C, which is used on many systems to abort a command), pressing Option-character 
causes the corresponding ASCII control code to be sent (NOTE, however, that if you are 
using Record mode, explained later, that the character may only be incorporated into the 
text in the input window rather than being sent immediately!).  

1.3:  Window manipulation 

WARNING:  Pressing the mouse button in a window's go-away box causes it (and any text in 
it) to be disposed of, unless the window is the Input, Output, or System window.  (The 
Input and Output windows will remain unchanged, while the System window will go behind 
all the other windows when the go-away box is used.) 

2:  Menu commands 

The command names and command-key equivalents (in parentheses) are accompanied by a brief 
explanation of their function.  If, when you attempt to execute a menu command using the 
mouse, the error message "out of RAM" appears, you should use the Free Memory command 
(Command--) to reorganize memory; if this does not free enough space, try eliminating 
some text or using smaller fonts. 

2.1:  Apple menu 

>About dumb virtue:  This menu item contains useful information about this program and 
licensing provisions. 

>Free Memory (-):  Prints the amount of memory free and then reorganizes memory so that 
space is used more efficiently (doing this twice  will yield a larger but somewhat 
unrealistic free memory estimate).  

2.2:  File menu 

This menu contains commands related to file access and printing. The file-related 
commands initiate dialogs based on the Macintosh Standard File dialogs.  These commands 
operate on the contents of the front window, which must be a text window. 

>Get (G):  Allows you to load a file from disk into the window. 

>Save (Z):  Saves the contents of the window in a file. 

>Save selection:  Saves the current selection range in the front window in a file. 

>Delete:  Deletes the file you select.  WARNING:  It doesn't ask twice. 



>Print selection:  This command will print the text selection in the front window.  If no 
text is selected, the whole text is printed.  It assumes that the printer is on the 
Printer Port.  WARNING:  The print routine is not the Macintosh-standard print routine, 
so don't expect to be able to use a LaserWriter.  The advantages to this approach are 
that it is MUCH faster when you are simply getting a hardcopy of some text printed, and 
the printed text is properly spaced (unlike Mac Print Manager draft mode text). 

>Printer reset:  Sets the printer's left margin, tab locations, and Top of Form.  Use 
this command before printing.  (The commands sent to the printer assume you are using an 
Imagewriter. The paper should be positioned so that the top of the page brushes the clear 
plastic cover.  If you are using a different brand of printer, you can initialize it by 
creating a file containing the escape sequences needed to set the margin, etc.  Literal 
input mode allows you to enter "non-printing characters" into a text window.) 

>New page:  Sends a form feed to the printer to start a new page and resets the line 
count to 0. 

>Cancel Print:  Cancels printing. 

>Cancel Send:  Cancels transmission of text sent using Shift or Option Enter. 

>Quit:  Exits the program and returns to the Finder.  WARNING:  The program does NOT ask 
whether you wish to save text which has been changed, so be careful! 

2.3:  Edit menu 

These commands affect the front window. 

>Undo (Z):  Provided for compatibility with desk accessories which support Undo. 

>Delete Right (Backspace):  Deletes the character (or selection plus one character) to 
the right of the cursor, placing a copy of this in the dv Scrap. 

>Cut (X):  Cuts the selected portion of text, keeping a copy in the dv Scrap. 

>Copy (C):  Copies the selected portion of text into the dv Scrap. 

>Paste (V):  Pastes the scrap into the text at the cursor; this replaces a selection 
range. 

>Clear:  WARNING:  Deletes the selected text without placing a copy in the Scrap.  Useful 
when deleting large amounts of text on a 128K machine, when there may be too little 
memory to hold a copy.  

>Select all (=):  Selects the entire text. 

>dv scrap->desk scrap:  Copies the text copied or cut into the desk scrap so it can be 
used by another program. 

>desk scrap->dv scrap:  Copies the current desk scrap into dumb virtue's text scrap. 

>Tag a-z set (T):  Saves the location of the selection range so you can go to that 
selection using the Yank command.  After selecting this command, you must press a key 



from a-z which will associate that range with that characer. 

>Yank tag a-z (Y):  Sets the selection range to the range associated with the key 
pressed, bringing the window to the front if necessary.  If no tag is associated with 
that character, nothing happens. 

2.4:  Cursor menu 

All of the following commands affect the current Input window. 

>Find cursor ('):  Scrolls text in the window so that the cursor is visible. 

>Set cursor (;):  Places the cursor in the middle of the window. 

>Left (H):  Moves the cursor left one position. 

>Down (J):  Moves the cursor down one line, where lines are separated by carriage 
returns. 

>Up (K):  Moves the cursor up one line, where lines are separated by carriage returns. 

>Right (L):  Moves the cursor right one position. 

>Word left (,):  Moves the cursor left one word in the text.  (Words are delimited by 
ASCII characters less than 32 decimal.) 

>Word right (.):  Moves the cursor right one word in the text.  (Words are delimited by 
ASCII characters less than 32 decimal.) 

>Sentence left ([):  Moves the cursor left by a sentence, which is either a Return or a 
'.', '?', '!', or ')' followed by two spaces. 

>Sentence right (]):  Moves the cursor right by a sentence using the same rule as the 
Sentence left command. 

>Page down (N):  Pages down in the window without moving the cursor. 

>Page up (M):  Pages up in the window without moving the cursor. 

>Anchor (A):  Sets one end of the selection range. 

>Select (S):  Sets the other end of the selection range. 

>Send line (Shift-Enter):  Pressing the Shift-Enter key combination sends the selected 
text in the current Input window to the host computer (see explanation of Input window 
below).  If no selection has been made, the program will send the host the contents of 
the current line to the right of the cursor if there is no selection.  Note that this 
command can be executed while the terminal window is in front. 

>Send all (Option-Enter):  Pressing the Option-Enter key combination causes all the text 
in the Input window to be sent. 

2.5:  Window menu 



The windows, which are numbered from 0 to 9, are controlled by the Window menu.  The four 
options at the top allow you to control the action taken when you select one of the 
windows. 

>UpFront (U):  Selecting "Up front" will cause the next window selected to be made the 
front window, in which selections can be made, and searches and the editing operations 
(in the Edit and Top menus) can be performed. 

>Input (I):  This window is marked in the window number list with a '<'.  Setting "Input" 
on will cause any text window selected to be made the "Input window."  In this window, 
the Cursor menu commands apply.  NOTE:  Typing only appears in the Input window when 
certain command options under the "Echo" menu are chosen. 

>Output (O):  The current output window is marked with a '>'.  Setting "Output" on will 
cause any text window selected to be made the "Output window."  Characters received from 
a remote computer will appear in this window.  There are two modes of operation which 
directly affect this window, CR = CR-LF and Literal output, both under the Echo menu. 

>Blank modes (B):  This command causes the Up front, Input, and Output options to be set 
"off" for easier use of these commands from the keyboard. 

>0-9 (0-9):  These items select one of the windows, setting it according to the Up front, 
Input, and Output options currently in force. 

Open:  Serves only as a heading and does nothing. 

>Terminal (D):  Selecting the "Terminal" option in the Windows menu brings forward a 
window which emulates an intelligent terminal.  This window does not save text off the 
top, so it can be used to avoid filling up memory with text you don't want to save.  
Because this window does not scroll evenly, it should be used with a terminal paginator 
such as the 4.2BSD UNIX "more" command when listing text longer than one page. 

The commands used are a subset of ANSI X3.64, which is similar to the command set for the 
DEC VT100; with most hosts, you should declare that you are using a VT100.  A 
"termcap" [and a "terminfo"] entry describing its functions is provided for use with UNIX 
systems. 

[>Tek 4010:  Emulates a Tektronix 4010 graphics display device.] 

>Scratchpad (`):  Brings the Scratchpad window to the front, makes it the Input window, 
and turns off transmission to the host (i.e., "Edit locally" in the Echo menu is set on).  
If the Scratchpad is in front, it will be sent behind and the old communications 
parameters restored.  This window is useful for holding input to be used in finding 
characters (e.g., type Command-`, type "Brings", type Command-S to set the selection, 
type Command-/ to set the search buffer, type Command-` to switch back to the previous 
window, and then--given that there is no selection which would become the default search 
string--you can type Command-/ to find "Brings"). This input can then be reused as 
needed. 

2.6:  Echo menu 

>Record input (R):  When this mode is on, all keystrokes are echoed into the Input 
window.  When the Return key is struck the line of text will be sent. 



>Edit locally (E):  When this mode is on, all keystrokes are echoed into the Input 
window, but they are not echoed to the serial port.  The one exception is when a Shift-
Enter or Option-Enter key combination is struck; these still perform their usual 
function. 

If the terminal window is up front, or both Record and Edit modes are off, characters are 
echoed to the host immediately. 

>Prompt skip (P):  This mode exists so that a line sent when Record mode is on, and the 
Input window and Output window are the same, will NOT include a system prompt which has 
been incorporated in the current line of local text.  The prompt MUST be followed by a 
space. 

>Break:  This command sends a break to the remote system. 

>Option-x = Control-x:  When this mode is on, option-key combinations are interpreted as 
control characters, which are only incorporated into text when the Literal input mode is 
on; when it is off, the option key makes the extended Apple character set. 

>Literal input:  When this mode is on, all input received from the keyboard is 
interpreted literally, so that you can insert control characters into your text.  

>Literal output:  When this mode is on, all output from the host received on the modem 
port is added to the output window without interpretation of any sort.  This mode is 
useful for analysing output from other devices when used in conjunction with an extended 
character set such as Mona, which allows you to see the non-printing characters. 

>Wrap output:  Brings up a dialog box which allows you to set the column position at 
which wrapping of text sent to the modem or printer will occur.  If you want no wrapping 
to occur, use a large number. 

>BS = DEL:  Causes a DEL (delete) character to be sent to the host computer when the 
Backspace key is struck. 

>CR = CR-LF:  This command switches the interpretation of Carriage Return and Newline 
characters sent from the host, and causes dumb virtue to incorporate as much text as 
possible into the output window at once.  This is useful in conjunction with certain 
terminal configuration options available on UNIX (the send newline only options--stty -nl 
option under 4.2 BSD, and similar options under SIII, SV, and their compatibles, such as 
XENIX).  When CR = CR-LF is set and the proper terminal mode is selected, the speed of 
transmission increases dramatically.  Turning off Scroll in the output window then allows 
you to examine the output at your own speed with the scrolling controls as text is added 
to the Output window. WARNING:  don't move the cursor around!  Remember, text gets added 
at the location of the cursor, not the end of text. 

>UNIX windows:  Sets up the program to function with John Bruner's uw program, which 
supports multiple virtual terminals under UNIX 4.2BSD.  Using this option, you can run 
several programs simultaneously in separate windows so their output is not mixed up. 
NOTE:  uw must be modified so that it does not set the terminal up as an adm31; this is 
easily accomplished by deleting two lines in uw.c: 

"TERM=adm31", "TERMCAP=adm31: ... " 

If you have uw at your site, ask your system administrator for help fixing this. 



>Input lag, >Output lag:  These options bring up a dialog box which allows you to set the 
length of time in ticks (60ths of a second) the program will wait to read input or write 
a line of output, respectively.  The read lag helps make character drawing more efficient 
by allowing the program to wait until a whole line can be drawn at a time; the output lag 
helps allow the uploading of files to hosts which cannot handle rapid input. 

>Set terminal wrap:  Sets the number of pixels at which the terminal window will attempt 
to scroll, so the window can handle long lines. 

2.7:  Comm menu 

>Modem/Printer:  Selects the default port on which Comm menu item choices take effect. 

>Modem port, or >Printer port:  Sets the port on which the device named above will be 
reading and writing, and on which the changes in the settings below will have their 
effect.  On setting the modem configuration, the windows are rearranged and the Echo 
modes are changed to the most useful configuration. 

>Baud:  Sets the baud rate of the port. 

>Parity:  Sets parity options for the port. 

>Stop Bits:  Sets stop bit options for the port. 

>Data Bits:  Sets the number of data bits expected by the port. 

2.8:  Fonts menu 

You can select any font available in your System file with this menu. If the font does 
not exist in the current size, you must select a new size before it will be displayed. 

2.9:  Size menu 

Using this menu you can select any real font size available for the current font. 

2.10:  Top menu 

Commands in this menu affect the front window.  

>Find selection (/):  Finds a string of characters in the front window matching 
(literally) the characters in the current selection range.  If no selection range is set, 
this command searches for the string used in the previous search.  If no match is found, 
the selection range is set back to the cursor. 

>Go to end (=):  Places the cursor at the end. 

>Scroll:  When scroll is on, the text in a window will move up when text is added and the 
cursor goes past the bottom.  

>Word wrap:  When word wrap is on, the text in a window will wrap around when the cursor 
goes past the right edge. 

>Label (TAB):  Causes a label to be drawn in the front window's title bar, containing 



information on the state of the program:  input/output status of the top window, three 
labels "REP" to indicate whether Record, Edit, and Prompt modes are on, three labels 
"UIO" to indicate whether a window will be made the Up-front, Input, and/or Output window 
when selected using a menu-key combination, and the length of the text in the front 
window. 

>Reformat Front:  This command reformats the text in the top window to fit into its 
current borders, and resets it to the top. 

3:  Some details 

3.1:  ANSI terminal emulator 

Following is a termcap file for Berkeley UNIX 4.2.  Use the entries for smaller screen 
sizes when you wish to use a larger font for your display.  The standard font, Mona 8, 
fits in a dumv-30 frame.  Monaco 9 fits in a dumv-28 frame, while Geneva 9 fits in a 
dumv-26 frame, and most 12-point fonts fit in a dumv-20 frame. 

#:AL=\E[%dL:DL=\E[%dM:DC=\E[%dP:\ #for gnuemacs DV|dumv-unk|dumb virtue: :im=
\E[4h:ei=\E[4l:mi:xn: :dc=\E[P:dl=\E[M:al=\E[L: :cr=^M:nl=^J:bl=^G:cl=\E[H
\E[J: :bs:am:cm=\E[%i%d;%dH:up=\E[A:do=\E[B:le=^H:nd=\E[C: :ce=\E[K:cd=
\E[J: :ho=\E[H:ta=^I:pt:sr=\EM: :cs=\E[%i%d;%dr: D0|dumv-12|dumb 
virtue: :is=\E[1;12r: :vs=\E[2J\E[1;12r: :co#80:li#12:tc=DV: D1|dumv-16|dumb 
virtue: :is=\E[1;16r: :vs=\E[2J\E[1;16r: :co#80:li#16:tc=DV: D2|dumv-20|dumb 
virtue: :is=\E[1;20r: :vs=\E[2J\E[1;20r: :co#80:li#20:tc=DV: #sc/rc only work w/ 
vi when 24 rows exactly due to vi bug D3|dumv-24|dumb virtue: :is=\E[1;24r: :vs=\E[2J
\E[1;24r: :sc=\E7:rc=\E8: :co#80:li#24:tc=DV: D4|dumv-28|dumb virtue: :is=
\E[1;28r: :vs=\E[2J\E[1;28r: :co#80:li#28:tc=DV: D5|dumv-30|dumb 
virtue: :is=\E[1;30r: :vs=\E[2J\E[1;30r: :co#80:li#30:tc=DV: D6|dumv-12-w|dumb 
virtue: :is=\E[1;12r: :vs=\E[2J\E[1;12r: :co#132:li#12:tc=DV: D7|dumv-16-w|dumb 
virtue: :is=\E[1;16r: :vs=\E[2J\E[1;16r: :co#132:li#16:tc=DV: D8|dumv-20-w|dumb 
virtue: :is=\E[1;20r: :vs=\E[2J\E[1;20r: :co#132:li#20:tc=DV: D9|dumv-24-w|dumb 
virtue: :is=\E[1;24r: :vs=\E[2J\E[1;24r: :co#132:li#24:tc=DV: DA|dumv-28-w|dumb 
virtue: :is=\E[1;28r: :vs=\E[2J\E[1;28r: :co#132:li#28:tc=DV: DB|dumv-30-w|dumb 
virtue: :is=\E[1;30r: :vs=\E[2J\E[1;30r: :co#132:li#30:tc=DV: 

3.2:  File uploading with UNIX 

TODO replace with new text from Bill's disk. 

3.3:  File uploading with other systems 

3.4:  Help files 

Help files are provided which can be loaded into windows from the Macintosh disk drive; 
these can be customized to make use of the UNIX system and its utilities less confusing 
to the naive user--or, alternatively, more convenient for the experienced user.  The 
contents of a window can be saved on the Macintosh disk, so that these "menus" can be 
easily modified by the user to suit his or her preferences. Similar menus can be 
constructed for use with any system. 

3.5:  Recommended settings 



The key-repeat speed should be set to 3 using the Control Panel desk accessory. 

4:  Lists of commands 

Commands sorted by name. 

Anchor selection: A
Blank modes: B
Clear:
Copy: C
Cut: X
Delete
Down: J
Edit locally: E
Find cursor: '
File: F
Free memory: -
Get: G
Go to end: =
Hunt for selection: /
Input: I
Label: Tab
Left: H
Literal input
Literal output
Output: O
Page down: N
Page up: M
Paste: V
Print selection:
Prompt skip: P
Reset printer:
Record input: R
Right: L
Save: F
Scroll:
Select: S
Select All:
Sentence left: [
Sentence right: ]
Set cursor: ;
Terminal: D
Undo: Z
UNIX windows
Up: K
Up front: U
Word wrap:
Word left: ,
Word right: .
New page:

Commands sorted by the key code. 



Set cursor: ;
Find cursor: '
Word left: ,
Word right: .
Hunt for selection: /
Anchor selection: A
Blank modes: B
Copy: C
Terminal: D
Edit locally: E
Save: F
Get: G
Left: H
Input: I
Down: J
Up: K
Right: L
Page up: M
Page down: N
Output: O
Prompt skip: P
Record input: R
Scroll:
Select: S
Tag: T
Up front: U
Paste: V
Word wrap:
Cut: X

Y
Undo: Z
Label: Tab
Sentence left: [
Sentence right: ]
Free memory: -
Go to end: =

5:  BUGS 

I've sidestepped many system bugs, but some are persistent.  "Systems software means 
never having to say you're sorry." 

Text is limited to about 32K.  

Sometimes the cursor in a text window will appear to be on the end of a line, but will 
actually be on the beginning of the next line.  Using the Reformat command or typing a 
Backspace at the very beginning of the text should fix this problem.  

Be careful about using too much memory on a 128K Mac; if your disk starts spinning 
frequently, it's a sign that the machine is releasing resources from memory in order to 
attempt to create enough space for some operation and then reloading them from the disk.  



You should close a window or delete some text to make more room. The Macintosh's memory 
management software can fail in mysterious ways, so be careful; use the Free Memory 
command in the Apple menu to find out how much space is used, and free up space if Free 
gets to be less than a few thousand bytes.  The best solution is to get a bigger Mac. 

Error messages and explanations: 

Beeping noises (no text output or entry)
A text window has become full, and so text processing has shut down
to prevent TextEdit from going wacko.  Shut off further output
(Control-C?) from the host and then you can restart output processing
with the Free Memory command.

disk full
The file could not be saved because the disk was full.

disk locked
The file could not be saved because the disk was locked.

file locked
The file could not be saved because the file was locked.

file > 32KB, too big
The file is too large for the Apple Macintosh standard 
text package, TextEdit.

Modem off
The modem must be on before you can use the Terminal command.

no close
The file could not be closed after writing.

no create
Couldn't create a file.

no delete
The file could not be deleted.

no fromscrap
no toscrap

For some reason the system scrap can't be copied to the text scrap
or vice versa.

no open
a window can't be opened because there is too little memory.  Try 
deleting unnecessary material.

no read
Couldn't read a file.

no serial write
The serial port is not open.

no write
The attempt to write the file to disk failed.

no update
The volume information has not been updated, so if your machine crashes your 
files may not appear on the disk anymore, even if you can currently 
access them.  WARNING:  If this notice appears on a Corvus system,
be careful!  The system may crash when you save files!.

out of RAM
You're short of space.  Try deleting unneeded material.  You can use 
Command - to reorganize memory and tell you how short you are.

Serial conf. failed
The serial port setting you attempted has failed.

unimplemented
Alas, the feature you have attempted to use does not exist.
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